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0) Introduction

Si vous savez déjà (même un peu) comment fonctionne un logiciel de production audio 
numérique, mais que vous ne savez pas encore comment faire de la musique avec, alors ce tutoriel 
est fait pour vous !

Vous apprendrez comment composer votre musique à la souris ou au clavier, écrire des partitions, 
installer, paramétrer et faire jouer des instruments très variés : le tout sans vous ruiner !

Ce tutoriel s'axera en trois parties :
La théorie où vous apprendrez le vocabulaire et les notions de base spécifiques à la MAO,
la pratique où vous commencerez à jouer avec les instruments,
ainsi que des notions avancées pour exploiter plus largement les possibilités offertes par 
l'environnement.

Vous aurez besoin de préférence :
– D'un ordinateur (sans blague), sous Windows ou Mac,
– D'avoir des notions de base en musique,
– D'avoir des notions de base sur l'utilisation d'un logiciel audio (Audacity par ex.).

Ce que ce tutoriel vous apprendra :
– Comment créer des partitions musicales numériques
– Comment installer, paramétrer et faire jouer des instruments virtuels

Ce que ce tutoriel ne vous apprendra pas :
– Les bases d'un logiciel audionumérique
– Comment bien composer

Vous trouverez des informations complémentaires à la fin de ce tutoriel, telles que des instruments 
et sons gratuits ainsi que les logiciels existants pour les faire jouer.
Mais avant de voir tout ça, il est temps de commencer...

* * *

Avis au connaisseurs :
Etant moi-même amateur de MAO, ce tutoriel ne fait pas non plus parole d'évangile.
Je m'efforce de rendre mes explications les plus claires possible, en les simplifiant pour qu'elles 
soient accessibles aux débutants.
Si cependant une erreur subsiste, n'hésitez pas à m'en faire part !
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1) Théorie

Cette partie est la plus courte, mais aussi la plus importante à connaître avant de passer à la 
pratique.

1.1) La MAO

Tout d'abord, qu'est-ce que la MAO ?
Ces initiales sont celles de la Musique Assistée par Ordinateur, et désignent l'ensemble des 
processus de création musicale où l'informatique est utilisée en tant qu'outil de production.

Il existe aujourd'hui des logiciels pour monter, mixer, composer, analyser, transformer la musique.
Parmi ces logiciels, on peux noter les suivants :

– Cubase
– Reason
– Logic
– Reaper
– Fruity Loops
– Pro Tools
– Sonar
– et bien d'autres...

Dans la partie « Pratique » ce tutoriel, nous utiliseront Reaper.

1.2) Les partitions numériques

a) Des sons et des partitions...

Un ordinateur, ça sait jouer des sons, c'est connu. Il en existe des tas de formats, WAVE et 
MP3 pour les plus connus. Mais à part les sons, il existe ce qu'on pourrait appeler des partitions 
musicales numériques. C'est exactement ce qu'utilise votre bonne vieille console, Game Boy ou 
Nintendo DS, pour faire de la musique : ils jouent des partitions !

b) Le format MIDI

En MAO, ces partitions sont généralement en MIDI.
MIDI (Musical Instrument Digital Interface) est un format de données qui existe depuis les années 
80, qui permet de véhiculer des données musicales.
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Alors que les sons comprennent chaque valeur de l'onde sonore à reproduire, les données MIDI 
contiennent les notes à jouer à tel instant, par qui et suivant divers paramètres. Le principe est 
réellement identique à celui d'une partition musicale. Cela rend d'ailleurs le format très léger 
comparé aux sons.

Sur votre ordinateur, ne partition MIDI est donc un simple fichier, possédant l'extension « .mid » 
Ou « .MIDI ».
Note : un fichier MIDI peut contenir plus d'une partition (canaux), en fonction du nombre 
d'instruments à mettre en place pour la jouer.

c) Les paramètres MIDI

Dans une partition MIDI, chaque note est accompagnée d'un certain nombre de 
paramètres qui déterminent comment il faut la jouer.
Imaginez que vous êtes devant un piano, et que vous lisez une telle partition. Elle se présentera 
comme suit :

Bon, je vous l'accorde, ça ne ressemble pas à une partition musicale, mais l'information est bien la 
même :
Chacune des notes est placée sur un graphe dont l'axe horizontal représente le temps, et l'axe 
vertical représente la hauteur de la note. En plus de cela, la note possède des attributs qui 
permettront d'appliquer des nuances. Voyons-en quelques uns :

La vélocité :
C'est la force avec laquelle vous jouez une note. Appuyez à fond sur une touche du piano,

et votre note sera dure et forte. Au contraire, effleurez doucement la touche et le son sera plus 
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doux et généralement moins fort.
Attention : ne pas confondre avec le volume sonore : La vélocité influe sur la force de la note, et 
non directement son volume final !

La durée :
Chaque note a une durée précise. Il s'agit tout simplement du temps pendant lequel que 

vous laissez une touche enfoncée. Graphiquement, la note sera donc étendue.

1.3) Les instruments virtuels

A présent que nous savons comment fonctionne une partition, il est temps d'apprendre... 
comment les jouer !
Si vous avez cherché un petit peu, vous aurez sans doute remarqué que votre ordinateur est déjà 
capable de lire les fichiers MIDI, certes avec une qualité quelque peu... limite !
Bon, c'est déjà ça me direz-vous, mais c'est pas avec le synthé système minimal qu'on arrivera à 
enflammer une boîte de nuit...

a) Le format des instruments

Heureusement, il existe des milliers d'instruments virtuels capables de lire ces partitions.
Il y en a pour tout les goûts: guitares, pianos, batteries, synthétiseurs, conteneurs, instruments à 
vent, à cordes, faiseurs de bruits, ambiances, moines qui chantent... (si, si! Même qu'il est gratuit 
et qu'il s'appelle Delay Lama^^)
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Bref, tout un monde !
Ce sont des plugins, des programmes très particuliers qu'un logiciel de MAO peut héberger.
Sous Windows, on peux trouver les plugins VST (Virtual Studio Technology).
Sous Mac, il y a les plugins AU, mais il existe des méthodes pour utiliser des VST sous Mac.
Il en existe d'autres formats, notamment RTAS pour Pro Tools ou NKI pour Kontakt.

b) Les types de plugins

Il existe principalement deux types de plugins :

– Les instruments, ce sont eux qui vont jouer des partitions. Sous Windows, ce sont les VSTi, 
avec « i » pour « instrument ».

– Les effets, ceux qui vont seulement modifier le son (ajout d'écho, correction des notes, 
compression, effet robot...).

Au cours de ce tutoriel, étant sous Windows, j'utiliserai le terme VST en tant qu'instrument virtuel 
par abus de language, mais souvenez vous bien de la distinction.

c) Les types de VSTi

Au delà de la division entre VST et VSTi, il existe plusieurs grandes classes d'instruments 
virtuels, dont voici les principales :

Les synthétiseurs :
Ces instruments créent leur son entièrement par calcul. Ils sont généralement utilisés pour la 
musique electro ou la techno. Certains d'entre-eux se basent sur un modèle physique, par exemple 
pour reproduire le son d'une corde pincée ou d'une flûte, uniquement à partir de formules 
mathématiques.

Les sampleurs :
Au contraire, les sampleurs se basent sur une banque de sons. Leur qualité dépend donc 
fortement de ces banques, et ils sont beaucoup plus lourds en taille que les synthétiseurs (à cause 
des banques).
On peux noter un groupe de ces VSTi, les lecteurs de soundfonts, que nous utiliseront plus loin.

Les hybrides :
Ces derniers mêlent les deux types précédents. Ils se basent souvent sur des sons existants et leur 
ajoutent des effets.

Les conteneurs
Ce sont des VST qui peuvent contenir plusieurs plugins, comme une sorte d'hôte. Par exemple, le 
Kontakt® de Native Instruments sert à ouvrir plusieurs instruments différents, encapsulés dans un 
format propriétaire.
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d) Qui se sert des instruments virtuels ?

Pratiquement toutes les musiques contemporaines (rap, pop, electro, techno) que l'on 
entend sur radio ou TV comportent de tels instruments. Mais les réalisateurs de musique de film 
aussi !
Figurez vous qu'il existe des instruments (trèèès chers) capables de reproduire des sections 
entrières d'orchestres et même des choeurs symphoniques !
Ces programmes ont été utilisés par exemple pour la musique du film Avatar, de nombreux jeux 
vidéo et la fiction sonore Velvorn, The Bladed Druid.
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2) Pratique

2.1) Mise en œuvre avec Reaper

Nous allons à présent passer à la pratique.
Si vous avez bien suivi la première partie, vous savez qu'on va avoir besoin d'un logiciel de MAO.

Mais lequel ? Mario Paint ? Et il faut payer ?
Non, pas Mario Paint, et je vous rassure, pour débuter, vous n'aurez pas à débourser un seul sou 
8-)
Pour pratiquer, nous allons donc utiliser le logiciel REAPER.

a) Pourquoi lui et pas un autre ?

C'est vrai, j'aurais pu choisir Fruity Loops ou Reason, qui sont très bien aussi.
J'ai choisi REAPER car je le trouve assez simple et ergonomique pour la création musicale en mode 
temporel, mais aussi parce qu'il est très accessible niveau prix :
La version de démonstration ne vous bloque pas au delà de 30 jours, seule une popup apparaîtra 
en vous forçant à attendre avant de commencer.
Mais acheter Reaper ne coûte pas un bras ! Cockos inc. propose même des prix réduits, aux 
alentours de 50 euros (quand on sait que Cubase en coûte 600...).
De plus, Reaper fournit exclusivement ce dont on a besoin, contrairement à d'autres gros logiciels 
qui incluent souvent une montagne de plugins destinés aux grosses productions.
Cela le rend donc beaucoup plus léger.

b) Installer REAPER

Allez sur le site internet de REAPER, dans la section downloads : 

http://www.reaper.fm/download.php

Choisissez la version qui vous convient (Mac/Windows), téléchargez et placez l'installeur où vous 
voulez, lancez-le et suivez les instructions.

Euh... c'est en anglais ?
Oui ! Mais ne vous en faites pas, pas besoin d'être un génie des langues pour savoir s'en servir. Ce 
tutoriel est fait pour ça !
Note : la version de Reaper que j'ai utilisée pour faire ce tutoriel est la 3.76. Il se peut qu'il y aie de 
petites différences si vous avez une autre version, notamment niveau design (vous pouvez 
retrouver le même dans les préférences/themes du logiciel).
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c) Et si j'ai déjà un logiciel ?

Si vous êtes en possession d'un logiciel audionumérique comme Cubase, Fruity Loops, 
Reason, Logic ou autre, vous pouvez quand même vous inspirer de ce tutoriel, vu que les principes 
d'utilisation se retrouvent plus ou moins différemment.

2.2) Prise en main

Ce tutoriel étant orienté création musicale, je ne ferai pas de description détaillée de la 
façon dont on se sert d'un logiciel audionumérique ; Je ne parlerai que de ce qui touche à la 
production de musique.

Note : si toutefois vous désirez en savoir plus sur les bases de Reaper, vous pouvez consultez ce 
tutoriel sur le forum Netophonix :

Mixer sous Reaper, par Istria : http://forum.netophonix.com/ftopic9599.html
Ou bien ce site internet qui en regroupe plusieurs :

http://www.benoitsanchez.net/timeless/collaboration/tutoriels-reaper.html

a) Créer un projet

Pour commencer, lancez Reaper et créez un nouveau projet.
Même si il est vide, vous pouvez commencer  par l'enregistrer :

Menu : « File → Save project As... »
Placez-le où vous voulez, de préférence dans un endroit ou vous le retrouverez.
Personnellement j'utilise un répertoire AUDIO\musique\reaper.

b) Présentation de l'espace de travail 
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–     En jaune : La barre d'outils où l'on peux activer un métronome (          ), annuler, refaire, 
aimanter la timeline, afficher ou non les graduations...

–     En rouge : la liste des pistes
–     En bleu : la timeline, où se trouvera tout ce qui devra être joué. Par défaut, elle est 

graduée en mesures musicales.
–     En vert : Le contrôle FX des pistes (ou la table de mix), où on verra plus tard comment 

ajouter des plugins.
–     En violet : le master, où l'on peux contrôler le volume sortant.
–     En orange : la navigation, pour lire, arrêter ou mettre en boucle.
–     En bleu clair ; les paramètres de lecture, dont la configuration du tempo

2.3) Faire jouer un instrument

Bon, on a un projet créé, mais il est un peu trop vide...
Qu'à cela ne tienne, on va mettre des choses dedans !
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a) Créer une piste

Première étape : on va commencer par créer une piste.
Pour cela, vous n'avez qu'à double-cliquer sur la liste des pistes à gauche de la timeline, ou utiliser 
le menu :

 « Track → Insert new track ».

Pouf ! Votre piste apparaît :

Remarque : votre piste est représentée à la fois à gauche de la timeline et dans la zone du contrôle  
de mixage, en bas de la timeline.

Vous pouvez dinstinguer certains boutons sur cette piste :
– Une grande barre de défilement pour contrôler le volume,
– Une petite barre de défilement pour contrôler la position spatiale du son de la piste (à 

gauche ou à droite),
– Un bouton [M] pour rendre la piste muette,
– Un bouton [S] pour faire jouer la piste en solo,
– Un bouton [Ar] pour armer la piste (on verra plus tard à quoi il sert),

Ainsi que les boutons [Io] pour gérer les entrées-sorties, [Env] pour l'automatisation et [Fx] pour 
les effets. Nous verrons ces derniers plus tard, on va commencer simplement :-)

Vous pouvez créer autant de pistes que vous le désirez (ou du moins, vous aurez du mal à atteindre 
le maximum en utilisation normale !).
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Correspondances avec le nouveau design :
Le nouveau design de Reaper 4.xx instaure quelques différences quant à ma description, voici donc 
la correspondance des boutons.

b) Créer une partition 

Vous vous souvenez des partitions MIDI ? Nous allons pouvoir en créer une sur notre piste.
Déplacez votre souris dans la timeline et sélectionnez une zone.
Celle-ci devrait se mettre en valeur.
Conseil : sélectionnez de préférence une zone de 4 temps allant de 1.1 à 2.1, en vous référant aux  
mesures en haut de la timeline. 

Faites « Insert → New midi item ».
Une bande apparaît sur notre piste :

Nous avons donc ici une partition qui dure 4 temps, pour bien correspondre au format du 
tempo. Elle a été créée selon la taille que vous avez sélectionnée. Vous pouvez en créer autant que 
vous voulez sur la même piste, et seront dimensionnées à la zone sélectionnée.

Vous pouvez lancer la lecture avec barre espace... et oui on n'entend rien, évidemment, elle est 
vide !
Astuce : activez le métronome dans la barre d'outils en haut à gauche et relancez la lecture. Vous  
entendrez les battements du tempo ;-)
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c) Ajouter un instrument virtuel

Nous allons maintenant ajouter un instrument virtuel.
Pour cela, cliquez sur le bouton [Fx] de votre piste :

Ne pas confondre « input FX » en rouge, qui liste les plugins associés à l'entrée du signal, et « FX », 
en vert, qui liste ceux associés à la lecture (ou sortie).
Ici, vous devez choisir celui qui est entouré en vert.

Deux fenêtres apparaissent :

La fenêtre ci-dessus vous montre tous les plugins que vous avez ajouté à votre piste (vous les voyez 
aussi dans la zone de mix). Pour le moment, elle est vide.
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La seconde vous montre tous les plugins installés, que vous pouvez ajouter à la piste (Vous en avez 
sûrement moins, mais ce n'est qu'une question de temps^^).

Allez dans la section VSTi, et choisissez le « ReaSytnth (Cockos) », un instrument intégré de base à 
Reaper :

Cliquez sur Ok.
Dans la fenêtre de derrière, votre VST apparaît !
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Houlà, c'est compliqué cet instrument, il a pas de clavier et que des barres bizarres !

Oui, et ce sera le cas pour beaucoup de plugins !
Bon, heureusement, les instruments virtuels ont généralement un look beaucoup plus fun que 
celui-ci. Ne touchez pas aux paramètres, nous verront cela en détail tout à l'heure.

Remarque : vous pouvez refaire toutes ces étapes en utilisant le menu suivant :
« Insert → Virtual instrument on new track ».

Vous pouvez aussi ajouter ou enlever rapidement un plugin en utilisant les contrôles de pistes, en  
bas de la timeline, en cliquant dans un espace libre (infobulle « Track insert FX »).

d) Voir la partition de plus près !

Il est bien joli notre instrument, mais il ne fait rien. Par défaut, comme il se trouve sur notre 
piste, il va jouer la bande de partition que nous avons créé. Et justement celle-ci est vide...
Double-cliquez sur cette bande : vous obtenez une fenêtre dans laquelle vous allez pouvoir écrire 
vos notes de musique !
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Et la revoilà, notre partition^^
Vous pouvez cliquer sur les touches de piano à gauche, vous allez voir, c'est marrant.
…
Ben quoi ? Vous venez de jouer vos premières notes, c'est pas merveilleux ?
Je l'admet, le ReaSynth ne fait pas des sons extraordinaires, mais il va vous permettre de vous 
familiariser un peu.
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e) Editer la partition 

à côté des touches de piano, vous avez une autre autre sorte de timeline graduée.
Les notes basses sont en bas, les notes aigues sont en haut. Elles sont alignées avec le clavier à 
gauche. Zoomez un peu pour avoir plus de précision (boutons [+] dans les barres de défilement).

Vous pouvez écrire vos notes librement en cliquant. Maintenez la souris enfoncée pour allonger la 
durée de la note. Plus le rectangle est long, plus la note durera longtemps.
Si vous vous êtes trompé de note, vous pouvez la déplacer librement en cliquant dessus.
Pour sélectionner plusieurs éléments, utilisez le clic droit maintenu.

Remarque : par défaut, vous pouvez ajuster la vélocité d'une note en attrapant une petite barre  
dessus et en laissant la souris enfoncée. Vous pouvez aussi le faire dans la partie inférieure de la  
fenêtre :

Comment on écrit des notes plus courtes ?
Vous pouvez remarquer que les graduations sont modifiables. En bas de la fenêtre, choisissez votre 
précision parmi les quantifications proposées :

Exemples :
– 1/4 : écrire des quarts de mesure
– 1/8 : écrire des huitièmes de mesure
– 1/64 : écrire des notes 64 fois plus petites qu'une mesure
– 1/8T : écrire des huitièmes + 1 tiers
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Toutes les mélodies sont écrites comme ça ?
Si vous travaillez à la souris, oui !
C'est fastidieux, malgré les outils que nous fournit Reaper (copier-coller, mise en boucle...).
Il est cependant possible de jouer au clavier d'ordinateur, et pour les mieux équipés d'entre-vous, 
au clavier-maître. Cette dernière option sera vue dans la partie « Notions avancées » ;-)

f) Mise en boucle

J'ai parlé de mettre en boucle, allons-y !
Quittez la fenêtre d'édition de partition et observez notre petite bande dans la timeline principale.
Déplacez votre souris sur l'un de ses coins : le curseur devrait changer d'apparence.
Cliquez sur le bord et tirez vers la droite en maintenant enfoncé :
Vous voyez la bande s'étendre !

Si vous avez écrit des notes dans la partition, vous les verrez se répéter au fur et à mesure que 
vous agrandissez la bande;-) 
Remarque : les encoches de la bande correspondent aux moments où votre partition reboucle.
Si vous éditez à nouveau votre partition, vous remarquerez que les modifications s'appliquent à 
chaque répétition.

Cette fonction est très pratique si vous voulez répéter un rythme de batterie, ou si vous avez une 
mélodie à jouer pendant tout le morceau.

Remarque : vous pouvez aussi copier-coller votre bande, mais cette fois la modification d'une copie 
n'affectera pas les autres.
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g) Changer le tempo

Un dernier détail avant de passer à la suite :
Si vous désirez changer le tempo (la vitesse de lecture) de votre musique, vous pouvez l'écrire dans 
la barre en bas à gauche de la timeline :

Par défaut, il est réglé à 120, c'est à dire une demi-seconde par temps.
Vous pouvez aussi choisir si votre musique se base sur du 4-temps ou du 3-temps juste à côté. 
Généralement, on utilise le 4-temps.

2.4) Installer un instrument

Enfin ! C'est maintenant que ça va être plus drôle.
Si vous étiez blasé par ce ReaSynth qui ne sortait qu'un bête son de téléphone, vous allez pouvoir 
installer de nouveaux instruments !

a) Où trouver des VST ?

Sur Internet ;-)
Il en existe des milliers, plus ou moins bons, plus ou moins chers, et les deux ne sont pas forcément 
liés^^
Votre choix dépendra de votre besoin. Si vous voulez faire de la techno, vous irez chercher des VST 
synthétiques. Si au contraire vous voulez faire de la musique classique, vous choisirez des VST 
sampleurs...

b) Choix et installation

Installer un VST est simple une fois qu'on a compris le principe :
Sous Windows, il s'agit généralement d'un fichier au format « .dll ».
Créez un dossier pour les rassembler. Personnellement, j'ai un dossier AUDIO/VST.
Conseil : prévoyez un emplacement large, car au bout d'un moment ce dossier va devenir très 
lourd^^ (quelques giga-octets chez moi pour une trentaine de VST)
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C'est fait, choisissons-en un !
Enfin presque, car pour illustrer ce tutoriel j'ai choisi de commencer fort et de vous montrer le TAL-
NoiseMaker, un  (très bon) synthétiseur ;-)
Rendez-vous sur le site de TAL et téléchargez-le :

http://kunz.corrupt.ch/?Products:VST_TAL-NoiseMaker

Décompressez l'archive obtenue directement dans votre dossier VST. Parmi les fichiers créés, vous 
remarquerez la présence d'une DLL (si vous êtes sous Windows)  : c'est la bête x)

Et c'est tout ?
Non, il reste à dire à Reaper où il doit aller chercher ses nouveaux VST :

« Options → Preferences »

Dans la fenêtre préférences, choisissez « VST » à gauche, et cliquez sur « Add... ».
Indiquez le dossier où vous avez installé votre (ou vos) VST(s), validez et appliquez.

Il ne vous reste plus qu'à refaire la même manip que pour ajouter un VST sur une piste :
« Insert → Virtual instrument on new track »

Dans la fenêtre de choix de VST, actualisez la liste des VST :
« FX → Scan for new plugins »

Et choisissez le TAL-NoiseMaker qui devrait apparaître dans les VSTi :-)
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c) Paramétrage

Oh my god ! Sympa le look ! Mais il y a encore plus de boutons OO''

Ah bon ? Vous trouvez ? On voit pire dans ce domaine xD
Essayez de jouer avec en récupérant le clavier de tout à l'heure (double-clic sur une partition MIDI, 
ou MIDI item) !

Pour commencer, on ne s'intéressera pas tout de suite aux jolis boutons, mais plutôt à la barre de 
paramétrage que nous ajoute Reaper, juste au dessus :

Vous avez une liste déroulante dans laquelle est écrit « ! Startup Juno Osc ». Il s'agit du réglage 
prédéfini (preset) que vous êtes en train d'utiliser. Choisissez parmi tous les autres, et vous 
découvrirez ce que ce TAL-NoiseMaker est capable de sortir comme sons =D

Le bouton [Ui] vous permet de désactiver l'apparence du plugin et de passer en affichage standard, 
pratique si on veux voir le nom réel des paramètres, mais pas très ergonomique.
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La case à cocher à droite active ou désactive le plugin : c'est le bypass.
Si vous la décochez, le plugin ne fera rien.

Vous avez aussi la possibilité de sauvegarder vos propres configurations ([+]). Libre à vous de 
trifouiller les réglages comme bon vous semble, mais pour ce qui est de leur signification, vous 
devrez vous reporter aux prochaines sections de ce tutoriel ;-)

2.5) Export

a) Rendu du projet

On a appris à créer des partitions, ajouter des instruments virtuels, les faire jouer et 
modifier les sons en utilisant les presets... vous pouvez entendre vos créations en faisant lecture 
dans le logiciel, mais comment transformer tout ça en son MP3 ou WAVE ?

Tout simplement en faisant le rendu par le menu.
« File → Export... »

Vous arrivez sur la fenêtre de rendu :

Elle a l'air compliquée, mais vous n'aurez pas à changer grand chose pour l'instant.
Contentez vous de cliquer sur « Browse... » pour choisir le nom et l'emplacement où vous voulez 
exporter votre musique.
Si vous laissez les options par défaut, votre travail sera exporté au format WAVE.
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Attention : Souvenez vous de la zone de sélection dans la timeline, car seule cette zone sera 
exportée !

A propos de la vitesse de rendu :
Reaper vous propose d'exporter votre musique en mode « Full-speed offline », c'est à dire le plus 
vite possible. Or, les instruments jouent habituellement en temps réel, et il arrive que sur de gros 
projets, des notes restent bloquées à cause d'un problème de performances ou de mémoire. Dans 
ce cas, vous pouvez sélectionner le mode « 1x offline », ce qui reviendra à enregistrer la musique 
dans sa durée normale. Cela prendra plus de temps, mais au moins, sur des ordinateurs peu 
puissants, les erreurs seront moindres. (basé sur une expérience personnelle)

b) Exporter en MP3

Sous Reaper, l'export en MP3 n'est pas natif, le logiciel ne peux pas le faire de base, car ce 
format n'est pas libre de droit. Vous aurez remarqué que si vous demander le format MP3 dans 
« Output format », le logiciel vous sort un « MP3 Encoder Missing ».
Si vous avez l'expérience du logiciel Audacity, sachez qu'il en va de même pour Reaper.

Cliquez sur « Download lame_enc.dll ».
Vous arrivez sur une page web, sur laquelle vous devez choisir de télécharger la version qui vous 
convient en fonction de votre OS (Windows ou Mac OS). Si vous êtes en 64 bits, prenez la version 
64.
Vous devez placez le fichier lame_enc.dll dans le répertoire où vous avez installé Reaper.
Chez moi, sous Windows, j'ai ce chemin : 

« ...\Program Files\REAPER »

Une fois ceci fait, vous n'avez qu'à redémarrer Reaper, ouvrir votre projet et exporter en MP3 !
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3) Notions avancées

Nous avons vu rapidement comment faire jouer des instruments rapidement. Dans cette 
partie, nous irons plus en profondeur dans le paramétrage des VST, leurs communication et leur 
automatisation, ainsi qu'une alternative plus pratique à l'édition à la souris et au clavier.

3.1) Paramétrer un VST

Vous avez vu que les plugins VST peuvent posséder d'innombrables paramètres, tous plus 
étranges et mystérieux les uns que les autres. Pour les amateurs, l’expérimentation (ou bidouille et 
on écoute) est une solution pour savoir à peu près ce que chaque bouton apporte comme nuance. 
Heureusement, d'un plugin à l'autre, on retrouve souvent des points communs. Nous allons ici en 
voir quelques-uns.

Reprenez votre projet Reaper, et rouvrez le petit synthé ReaSynth (ou TAL-NoiseMaker si vous vous 
sentez d'attaque !). Ouvrez également la partition pour tester les sons que vous configurerez.

Vous aurez remarqué que les synthétiseurs comportent beaucoup de réglages. Ça peut faire peur 
au premier abord, mais bien souvent, tous ces réglages sont groupés en plusieurs catégories plus 
simples. Ces catégories forment alors une suite de traitements que va subir le son avant d'être 
émis.

Par exemple, sur le TAL-NoiseMaker, on retrouve 2 oscillateurs (OSC1 et OSC2), un filtre (Filter), 
une enveloppe (ADSR), une série d'effets intégrés et un contrôle de sortie (Master).

Voyons plus en détail ce que tout cela signifie !
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a) La synthèse du son

Comme leur nom l'indique, les synthétiseurs fabriquent le son artificiellement, grâce à des 
calculs numériques. Pour cela, on utilise des formes d'ondes de base (aussi appelées primitives, 
shapes ou waveforms en anglais), très simples, pour ensuite leur appliquer des effets divers.

Mais qu'est-ce qu'une forme d'onde ?

Un son peux être décomposé en une multitude d'ondes plus simples.
Dans l'analyse de Fourier, un son est considéré comme périodique, c'est à dire que ses 
composantes se répètent au cours du temps (notions de maths!). Il a alors été démontré que tous 
les sons peuvent être reproduits par une somme de sinusoïdes, l'onde pure par excellence :

Synthèse additive d'une onde périodique

Les synthétiseurs fonctionnent sur le même principe, en faisant des opérations à partir d'ondes 
simples.
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Cependant, pour des raisons de performance, on triche un peu et on rajoute des formes d'onde 
autres que la sinusoïde pour former le son final. Cela évite beaucoup de calculs car ces primitives 
sont en général bien connues :

Nom Apparence Caractéristiques

La primitive square (carrée) Un son saturé, semblable aux premiers bips 
émis par les ordinateurs ou les consoles

La primitive sine (sinusoïdale) Un son doux, que l'on peux entendre au 
téléphone

La primitive triangle Entre le sine et le square

La primitive saw tooth (dents  
de scie)

Un son pinçé, semblable à celui des 
instruments à cordes

Sur le ReaSynth, on retrouve des paramètres permettant de mélanger ces primitives.
Lorsque « Mix » est mentionné, il s'agit d'un mélange entre deux parties du son.

Sur le TAL-NoiseMaker, on retrouve 2 oscillateurs, donc 2 primitives qui mélangées qui passent 
ensuite dans une série de filtres pour obtenir le son final.

b) Contrôle du pitch

Beaucoup d'instruments permettent d'ajouter des nuances de hauteur à leurs notes, grâce 
à un paramètre comme le « tuning » ou le  « pitch ». Vous pouvez le retrouver dans les oscillateurs 
du TAL-NoiseMaker.
Ce paramètre fait varier la hauteur de la note que vous jouez. Si vous augmentez sa valeur, la note 
sera plus aigüe. Au contraire, si vous la baissez, elle sera plus basse. Vous pouvez même modifier 
cela alors qu'une note est en train d'être jouée, ce qui peux donner des roulements (ou 
glissandos) qui donnent de la « vie » au son!

Remarque : Sur certains instruments, un second paramètre « fine » vient compléter celui-ci, qui 
permet plus de précision dans le réglage de la hauteur.

Certains instruments comportent également un paramètre « glide » ou « glissando », qui 
permet de donner un effet de glissement plus ou moins long entre les notes. Par exemple, si vous 
jouiez un do suivi d'un sol, l'instrument émettrait une note qui monterait graduellement de do à 
sol de façon continue, comme si l'instrument « chantait ».
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Vous pouvez tester cet effet sur le VST gratuit suivant : 

MinimogueVA
http://home.no/gunnare/index.htm

Comment l'installer     ? Rappel >>  
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c) L'enveloppe sonore

L’enveloppe sonore est l'une des propriétés d'un son instrumental renvoyant à l'évolution 
de son amplitude (son volume) au cours du temps.  Il existe plusieurs modèles d'enveloppe, le plus 
commun étant l'ADSR : Attack, Decay, Sustain, Release.
On retrouve ces 4 paramètres sur le ReaSynth.

Source : Wikipédia
Ce schéma représente l'évolution d'une note à laquelle est appliquée l'enveloppe ADSR.

Voici la description de ces 4 paramètres :
Attack     :   le temps qu'il faut au son pour atteindre son amplitude maximale
Decay     :   le temps qu'il faut au son pour atteindre son état de maintien
Sustain     :   amplitude du son lors du maintien (quand on laisse une touche appuyée par exemple)
Release     :   le temps qu'il faut au son pour s'arrêter quand on a relâché la note.

La modification de cette enveloppes influe sur le dynamisme du son.
Par exemple, un instrument leader (au centre de la mélodie) aura une attaque et une release assez 
courtes pour pouvoir enchaîner les notes rapidement, 
tandis qu'un instrument de fond continu (texture, pad) aura une attaque et une release plus lentes.
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3.2) Effets communs (filtres)

Cette partie traite de quelques effets simples que l'on peux trouver intégrés à un plugin.
Ils sont applicables aussi à l'audio, et pas seulement à la musique.

a) Dry / Wet / Mix

Les effets possèdent souvent des paramètres « dry / wet», ou « mix ». Ils déterminent dans 
quelle mesure un effet est appliqué, plus ou moins fortement.

Dry : quantité de son entrant
Wet : quantité de son modifié
Le mix est un rassemblement de ces deux paramètres.

Note : Reaper inclus un paramètre dry/wet également sur les instruments virtuels. Cela revient à 
contrôler leur volume, mais il faut bien savoir qu'en réalité c'est la chaîne vue ci-dessus qui 
s'applique.

b) Reverb

Cet effet représente la réverbération du son dans son environnement. Lorsque vous êtes 
dans une grande salle et que vous tapez des mains, le son met beaucoup de temps à s'éteindre, car 
il rebondit sur des surfaces proches ou très éloignées.

Dans cet effet, on retrouve généralement les réglages de la taille de l'environnement (Roomsize), la 
durée entre l'émission du son et sa première réverbération (Pre-delay) ainsi que la durée de la 
reverb (Length ou Time).

c) Delay

Semblable à la reverb, cet effet produit de l'écho. Il possède en général des paramètres 
pour régler la durée entre deux échos (Delay time), la quantité d'échos (Feedback) et le taux de 
décroissance du volume entre deux échos (Mix).
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d) Vibrato

Cet effet module la hauteur son plus ou moins rapidement. On peux régler sa vitesse (rate), 
et sa variation de hauteur (depth).

e) Chorus

Le chorus est un effet sonore un peu plus complexe obtenu en additionnant au signal 
d'origine un même signal légèrement retardé avec une légère variation de fréquence (un 
"vibrato"). Il permet à partir du son d'un instrument unique d'obtenir un son de chœur 
d'instrument, plus épais et ample :

Le Taux (Rate) :
Il s'agit du taux de la fréquence de modulation, c'est à dire la vitesse du vibrato du son modulé.

La Profondeur (Depth) :
Il s'agit de l'amplitude de la fréquence de modulation, c'est à dire la force du vibrato du son 
modulé.

Le Temps de Retard (Delay Time) :
C'est le délai qui sépare le signal original et le son modulé.

Le Nombre de Voix ajoutées (Chorus Size) :
C'est le nombre de signaux modulés ajoutés au son original.
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3.3) L'automatisation

On a vu que les plugins pouvaient être largement paramétrés, mais jusqu'alors on ne 
changeait pas leur valeur au beau milieu de la musique. Dans cette partie, nous allons voir 
comment les faire évoluer automatiquement !

a) Faire varier un paramètre

Pour commencer, on va juste se baser sur le paramètre « Pan »:
Le pan indique de quel côté provient le son d'une piste, de gauche à droite.
Prenez votre piste avec votre instrument dessus, et ajoutez-y quelques notes histoire qu'il joue un 
peu.
Dans votre piste à gauche de la timeline, cliquez sur le bouton [env] :

Une magnifique fenêtre s'ouvre à vous...

Celle-ci contient tous les paramètres que vous pouvez automatiser. Si vous avez conservé le TAL-
NoiseMaker, il doit y en avoir un sacré paquet, plus que sur le screenshot de ce tutoriel^^
Parmi la catégorie « Track enveloppes »,  choisissez « Pan ».
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Aussitôt, une sous-piste apparaît en dessous de votre piste :

Vous devriez voir une ligne. Elle est horizontale, signe que le paramètre est réglé à zéro tout au 
long du morceau. Essayez de bouger cette ligne à la souris, tout en faisant jouer le morceau :
La musique change de position spatiale!

Mais ça ne nous avance à rien, vu que nous ne voulons pas une valeur constante, mais dynamique.
Pour cela, on va devoir créer des points sur la ligne, et la transformer en courbe en faisant varier 
ces points.
Faites un clic droit à une position de votre choix.
Un menu apparaît, choisissez « Create new point ».
Pouf ! Un nouveau point est apparu sur la ligne.
Répétez l'opération autant de fois que vous le désirez.
Une fois que vous avez vos points, vous pouvez les déplacer. C'est ainsi que vous ferez varier votre 
courbe !

Vous pouvez effacer des points en sélectionnant un groupe de points avec le clic droit,
et touche [Suppr].

Comment placer un point entre deux graduations ?
Vous ne pouvez pas le faire car l'aimantation est activée par défaut. Elle permet de garder le 
rythme lorsque vous changez la position des objets. Si vous voulez plus de précision, désactivez 
l'aimant dans la barre d'outils   (infobulle « snap »).
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b) Faire varier n'importe quel paramètre 

Maintenant que vous avez vu comment modifier un paramètre, sachez qu'il en va de même 
pour tous les autres, y compris ceux de vos plugins !
Vous pourrez modifier la forme d'onde du ReaSynth en plein milieu, désactiver ou activer un effet 
à certains endroits, faire de l'écho à un point précis de la musique... c'est là toute la puissance de 
l'automatisation :-)

Et si je veux automatiser plus d'un paramètre ?
Il vous suffit de cliquer à nouveau sur [env] et de choisir un nouveau paramètre. Vous pouvez aussi 
cacher l'automatisation des autres en cliquant sur [x] et « Hide enveloppe ».

3.4) La communication entre pistes

Dans cette partie, on va aller encore plus loin : Imaginez que vous ayez besoin de faire jouer 
plusieurs instruments, mais que deux d'entre eux soient identiques : vous allez devoir les charger 
deux fois !
Nous allons voir ici que ce problème peux être résolu en utilisant les canaux (channel en anglais).

a) Faire jouer plusieurs partitions par un instrument

Saviez vous qu'un instrument était capable de jouer plusieurs partitions en même temps ?

Mais... comment c'est possible ? On ne peux pas se faire chevaucher deux partitions !

En effet, c'est pourquoi nous allons créer une seconde piste ;-)
Créez une seconde partition dessus (« Insert → New MIDI item »), mais ne rajoutez pas de plugins.
Ecrivez des notes dedans, puis cliquez sur le bouton [io] de la piste.
La fenêtre des connexions de votre piste apparaît :

Vous aurez remarqué que chacune de vos pistes possède un numéro. En l'occurence, nous 
travaillons sur la 2ème.
Cliquez sur « Add new send » et choisissez « 1 : », la première piste, celle sur laquelle il y a un 
instrument.
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De nouvelles informations apparaissent, n'y touchez pas pour le moment.

Lancez la lecture... et magie !
L'instrument que vous avez placé sur la première piste lit à la fois la partition de sa piste ET celle de 
la 2ème.

Mais quel est l'intérêt ? On n'a qu'à écrire toutes les notes sur une partition, non ?

Au contraire, cela permet de vous organiser, par exemple si vous voulez dissocier les mains 
gauches et droites d'une musique au piano, ou la mélodie et les basses.
Mais nous allons surtout voir que pour certains instruments, cette technique est indispensable.

b) Utilisation d'un lecteur de soundfonts

Nous allons faire une petite pause dans cette rubrique afin d'aller chercher un tout 
nouveau VSTi, qui va nous permettre de mettre en pratique les canaux MIDI.
Rendez-vous sur le site de Prodyon pour télécharger Phenome, un sampleur qui lit des soundfonts.

http://www.prodyon-virtual-gear.com/crbst_7.html

Installez-le au même endroit que vos autres VST, vous devriez avoir l'habitude à présent^^
Actualisez les plugins disponibles pour Reaper (« Scan for new plugins »).
Enlevez tous les plugins que vous avez mis sur la 1ère piste, et ajoutez-y Phenome.
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Bam ! Encore un truc plein de boutons !
Oui, mais cette fois il y a du nouveau :
Phenome est un sampleur qui vous permet de jouer jusqu'à 8 sons différents, observez la liste 
(vide) en haut des paramètres. 
Vous trouverez ces sons dans des banques de soundfonts au format SF2.

Mais... je n'ai pas de banques !

Nous allons donc aller en chercher !
Suivez ce lien pour télécharger des banques de soundfonts directement :

http://www.newgrounds.com/bbs/topic/1200140

J'ai gardé ce lien car beaucoup de sites demandent un compte utilisateur pour télécharger des 
banques. Ne vous embêtez pas à tout prendre, une seule suffira (L'une d'elles ne pèse que 28 Mo).
Ce sont essentiellement des soundfonts adaptés à la musique orchestrale.

Placez-les où vous voulez, de préférence là où vous les retrouverez.
Personnellement, j'ai un dossier « AUDIO\SONS\samples\sf2 ».
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Les banques SF2 peuvent contenir un seul ou plusieurs sons.
Pour charger une banque dans Phenome, utilisez le petit explorateur intégré sur sa droite
(Si il vous sort une fenêtre « Error SF2 file not found ! », ignorez-la, faites OK).
Vous pouvez en même temps tester les sons, histoire de voir lequel vous plaît.
Chargez au moins deux sons comme ceci :

Vous remarquez que vous ne pouvez jouer qu'un seul de ces sons, le premier.
C'est pourquoi la prochaine rubrique vous expliquera l'intérêt des canaux

c) Utiliser les canaux

Si vous n'avez pas déjà deux pistes avec des partitions dessus, créez-en une deuxième.
Sur votre deuxième piste, cliquez sur [io].
Enlevez tous les sends que vous avez préalablement créés en cliquant sur [delete].
Ajoutez un nouveau send vers la première piste (la « 1 : », celle où se trouve Phenome), et cette 
fois-ci nous allons indiquer à la piste sur quel canal envoyer ses notes :
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Sur la ligne « MIDI », on peux lire que tous les canaux de la piste courante envoient leurs notes vers 
tous les canaux de la piste 1 (bien sûr Phenome ne jouera qu'un canal par piste, pas fou le 
vieux^^). Pour que notre piste envoie ses notes au 2ème son de Phenome, il suffit de choisir le 
2ème canal dans la deuxième liste déroulante :

Testez et profitez !
Vous pouvez faire cette manip pour autant de pistes et de sons que peux jouer Phenome (8).

d) (presque) fini !

Si vous êtes arrivés jusqu'ici, félicitations !
Vous avez dès à présent assez de connaissances pour créer vos propres musiques.
Il vous faudra certainement plus de pratique et de savoir musical avant de pouvoir composer et 
réaliser des morceaux entiers, mais les bases que vous venez d'apprendre seront essentielles pour 
vos futurs projets ;-)

3.5) Contrôle au clavier

Il reste une dernière partie à aborder, notamment pour les mieux équipés d'entre vous.
Vous avez remarqué à quel point il est fastidieux de tout faire à la souris. C'est vrai quoi, comment 
peut-on composer si on a pas de vrai clavier de piano ?

a) Clavier d'ordinateur

Reaper intègre un clavier virtuel que vous pouvez contrôler au... clavier de votre ordinateur.
Il vous suffit de l'activer en allant dans le menu suivant :

« View → Virtual MIDI Keyboard »
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Un clavier apparaît, et vous pouvez désormais utiliser les touches de votre ordinateur comme des 
touches musicales ! Cependant, pour vous en servir, une manip' supplémentaire est à effectuer, 
nous allons la voir plus loin.

b) Clavier-maître

Si vous possédez un clavier MIDI (clavier-maître) que vous pouvez brancher à votre 
ordinateur, vous pouvez configurer Reaper pour contrôler vos instruments via les touches 
musicales et boutons de votre clavier !

Note : si vous utilisez le clavier virtuel, vous pouvez passer l'étape de branchement et de 
configuration du clavier-maître, les autres manips étant inutiles.

Vérifiez que votre matériel est installé (drivers).
Branchez votre clavier directement (ou via une interface) avec un câble USB ou une entrée MIDI (si 
votre ordinateur en possède une), Allez dans « Options → Preferences... », puis dans l'onglet 
Audio : MIDI Devices.
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Dans MIDI inputs, vous devriez trouver votre clavier MIDI, ou votre interface audio le cas échéant. 
Double-cliquez dessus et activez la réception des signaux MIDI (« Enable input from this device »).

Pour le moment, vous ne pouvez pas encore jouer d'un instrument.
Pour cela, créez ou choisissez une piste avec un instrument dessus.
Cliquez ensuite sur le VU-mètre de la piste pour lui assigner une entrée MIDI :

Dans le deuxième menu, vous pouvez voir différentes sources MIDI :
– Virtual MIDI Keyboard, qui est le clavier virtuel intégré à Reaper (vu précédement),
– UA-25, une interface audionumérique (ici la mienne),
– All MIDI Inputs, qui représente toutes les entrées précédemment citées.
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En choisissant une source, vous pouvez choisir sur quel canal la piste va recevoir le signal.
Choisissez « All Channels » si votre instrument n'utilise pas plusieurs canaux, sinon choisissez le 
canal sur lequel vous désirez jouer (avec Phenome par exemple).

Et pourtant même avec ça, aucun son ne sort !
Mais le signal MIDI est pourtant capté, si vous appuyez sur une touche de votre clavier-maître (ou 
du clavier virtuel), vous verrez que le VU-Mètre réagit.

Pour entendre le son de l'instrument,
vous n'avez qu'à cliquer sur le petit bouton de monitoring :

Et maintenant, vous pouvez entendre ce que vous jouez !

b) Enregistrer 

Pour vous enregistrer, il n'y a pas grand chose à faire :
Après avoir choisi et configuré votre piste, cliquez sur le bouton [AR] pour armer la piste :

Seules les pistes armées enregistreront les notes que vous jouez.
Vérifiez que vous n'avez pas d'autres pistes armées en même temps, pour éviter de jouer par 
dessus.
Quand vous êtes prêts, cliquez sur le bouton d'enregistrement ! 

A vous... de jouer !

41/43

Theme v3.xx Theme v4.xx

Theme v3.xx Theme v4.xx



4) Annexes

4.1) Des instruments gratuits

Sites de téléchargement d'instruments gratuits (vous devrez créer des comptes pour télécharger 
certains) :

http://www.native-instruments.com/#/en/products/?category=1339
http://www.yellowtools.us/cp21/cms/index.php?id=842
http://www.ikmultimedia.com/sampletankfree/features/
http://www.vst4free.com/
Google est votre ami !

Vous pouvez aussi devenir membre et vous inscrire à la newsletter du site Audiofanzine, car ils 
présentent un nouveau freeware toutes les semaines :
http://fr.audiofanzine.com/

4.2) Des banques de son gratuites

SF2 :
http://www.newgrounds.com/bbs/topic/1200140
http://soundfonts.homemusician.net/
http://www.sf2midi.com/soundfonts/
SAMPLES  :
http://www.musicradar.com/news/tech/sampleradar-13154-free-sample-downloads-217833
http://www.universal-soundbank.com/
http://www.freesound.org/
Google est...

4.3) Des logiciels...

http://www.steinberg.fr/fr/produits/cubase/start.html
http://www.propellerheads.se/products/reason/
http://www.apple.com/fr/logicstudio/
http://flstudio.image-line.com/
http://www.reaper.fm/
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4.4) Réductions pour les étudiants

Si vous êtes étudiant et que vous cherchez des réductions sur des plugins payants, vous 
pouvez en trouver sur le site de Ohm-Force :

http://www.ohmforce.com/ViewPage.do?key=students
Merci à Xzimnut pour cette trouvaille !
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